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How To Mind Map

1.

9.

Turn a large A4 (11.7" x 8.3") or preferably A3 (16.7" x 11.7"), white
sheet of paper on it's side (landscape), or use a Mind Map pad.

. Gather a selection of coloured pens, ranging from fine nib to medium and

highlighters.
Select the topic, problem or subject to be Mind Mapped.
Gather any materials or research or additional information.

Start in the centre with an unframed image — approximately 6¢cm high and
wide for an A4 and 10cm for an A3.

Use dimension, expression and at least three colours in the central image
in order to attract attention and aid memory.

. Make the branches closest to the centre thicker, attached to the image

and ‘wavy’ (organic). Place the Basic Ordering Ideas (BOIs) or the
‘chapter heading' equivalents on the branches.

Branch thinner lines off the end of the appropriate BOIs to hold
supporting data (most important closest).

Use images wherever possible.

10.The image or word should always sit on a line of the same length.

11.Use colours as your own special code to show people, topics, themes or

dates and to make the Mind Map more beautiful.

12. Capture all ideas (your own or others’), then edit, re-organise, make more

beautiful, elaborate or clarify as a second stage of thinking.
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Mind Map Laws

These are the brain-reflecting foundation structures of a Mind Map.
The more of them you follow, the more effective your Mind Map.

1. Start in the centre with an image of the topic, using at least 3 colours.

2. Use images, symbols, codes and dimensions throughout your
Mind Map.

3. Select key words and print using upper or lower case letters.
4. Each word word/image must be alone and sitting on its own line.

5. The lines must be connected, starting from the central image. The central
lines are thicker, organic and flowing, becoming thinner as they radiate
out from the centre.

Make the lines the same length as the word/image.
Use colours — your own code — throughout the Mind Map.

Develop your own personal style of Mind Mapping.

© o0 N o

Use emphasis and show associations in your Mind Map.

10. Keep the Mind Map clear by using Radiant hierarchy, numerical order or
outlines to embrace your branches.
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Uses
Learning

Overviewing

Concentrating

Memorising

Organising

Presenting

Benefits

Reduce those ‘tons of work’. Feel good about study, revision and
exams. Have confidence in your Iearnlng abilities.
’Lmﬂmmamaﬂmnluﬂmmm mI3uuntsie Wensatufin wdhnauwn
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See the whole picture, the global view, at once. Understand the links
and connections.
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Focus on the task for better results. Using all of your cortical skills

attracts your attention.
MIAUTAINUTEEUAIIRB AL NN T IEN N B TINTAININ S

Easy recall. ‘See’ the information in your mind’s eye.
Sifp) ﬂluﬂ']ﬁ‘i'}ﬁagaﬂnmi

Be on top of all of the details for parties, holidays, projects or any
other subject.
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Speeches are clear, relaxed and alive. You can be at your best.
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Communicating

Planning

Meetings

Training

Thinking

Negotiating

Brain Blooming

In all forms with clarity and conciseness.
nresfiszansnwanndu das Mind Map

Orchestrate all details and aspects — from beginning to end — on one piece of
paper.
mMIMuNwidlEnTa wuunszenmis s lifniin

From planning to agenda, to chairing, to taking the minutes ...
completed with speed and efficiency.
NMIWURKMIYTETY Buniwuan1s maim ey fan s ieSesuladadnd

the jobs are
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From preparation to presentation they make the job easier and much faster .
nlIauld mmeu(ﬂawuaamsmsmmms‘lﬂaummsmLaua mnl%msmmumwu vlwmmn
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Having a method to analyse thoughts — almost a ‘way-station’ for them.
msﬂszqnﬂ%ﬁmmﬂwmmﬁ@ Lﬂumaaanlmammﬁm INAUINTT

All the issues, your position and manoeuvrablllty in one sheet.
msmsﬁnﬂasaammmumwmmamwmﬁmmm"nuwm muﬂuwmtmamsuaamw yad
ﬂzyml,muaamw

The new brain-storming in which more thoughts are generated and

appropriately assessed.
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Rearrange branches into logical order

Use colors and boundaries
for classification

Use highlights for emphasis

) _ .. Assign priorities or other
@ P 8 & stock icons where useful

Connect dependent ideas

Clarify, discuss
and prioritize

with relationship arrows

Web site

If necessary,
convert a map
into

Word document

PowerPoint
presentation

istribute completed
map to participants as a
record of the session

Evaluate

Test

Identify practical
solutions

Review

Next steps .
Create action plan

Dates map

Responsibilities ~

Info Map Brainstorming.mmap - 6/7/2005 - Mindjet Team

I. The Group

{ IV. Post-session work

MindManager
for Brainstorming

Reviews guidelines

Provides definition of problem

Stay focused

€ Leader Controls session

No domination

Creativity

Encourages o
Participation

From diverse backgrounds

Participants ]
Broad range of experience

May or may not participate

\m’ Recorder / Enters ideas in MindManager

\ Entries are anonymous

Extend session if

© set a time limit ideas are flowing

Il. The Guidelines

Anything goes!

@ No criticism or qualifying of ideas

The more ideas, the better

Start MindManager's Brainstorm mode

Random order OK

Enter ideas as they come

I1l. The Process

© Mindjet 2003

Keep up with the flow

Topics for new ideas

Subtopics expand existing ideas




Printed maps keep
information at your fingertips

Create informational

ile->
2 File->Save As Web Pages Web site

 File->Send To->Word Document

Export to Word in

As notes for presentations ‘ outline form

As the basis for a
more detailed paper

File->Send To->PowerPoint

) Presentation Create a PowerPoint

Presentation

Arrange topics into a hierarchy

Colors for classification

Highlights for emphasis

Boundaries for grouping

Add visual cues

Icons and
images for
meaning

Relationship arrows show
connections and dependencies

.

o

Use Multimaps to link related maps
together

{

K
B
.
.
..............

Info Map Information Management.mmap - 6/7/2005 - Mindjet Team

IV. Use

Information

|. Define

Information Needs

MindManager for
Information Management

Ill. Organize
Information

© Mindjet 2003

1

Il. Collect
Information

Create a map with a
set of general topics

For large amounts
of information use
several Multimaps

Use a Topic for
each category

Use Subtopics, Callouts
and Floating Topics

Summaries
Create Notes ]
Literature references

Link to related Text documents

documents using
hyperlinks

Graphics

Spreadsheets
. Web pages




Define the

meeting objective Use the Central Topic

Reorganize and reword

Brainstorm topics Create a Main Topic
Stay true to actual events for discussion

State the objective for the topic

Code special items

O @& @D icons €.g. consensus Keep to a reasonable number of topics
opinions and . .
Colors decisions Edit the map Reorganize and Use Subtopics for
. prioritize topics to categories within Topics
Fill/Highlights /",' e, create an Agenda

Relationship Indicate
arrows

——— . dependencies

|. BEFORE
the meeting

Distribute prior to meeting to help
participants prepare

Optional Arrive and start on time

Include a Topic with Stick to the agenda

meeting guidelines, for Focus discussion on the agenda
example:

°e Place most important topics first

lll. AFTER
the meeting

Reminder of meeting outcomes

Basis for future actions

Distribute to
participants

Map MindManager for

Meeting Management

Web site Listen to understand

Word document
PDF

Publishing options

Respect different view points

End on time

Direction

Refer to Agenda map [ Focus

Objective
KUse Focus on Topic (F3) command

For each topic

Encourages participation

Record ALL
contributions /Instills confidence

II. DURING
the meeting

Collect ideas on \ Fosters creative thinking
agenda map ‘

Include a Topic to
‘ collect unrelated ideas
for future consideration

© Mindjet 2003

Note consensus decisions

Info Map Meeting Management.mmap - 6/7/2005 - Mindjet Team
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ainstorming
* No Criticism
* Freewheel
* Quantity

* Record all 10eas
* Incubate

@ Monitor and evaluate

! Implement solutions
— : J @ Present solutions
=

Cost-benefit analysis

@ Agree the best solutions

Pr0b|em-SO|V|ﬂg mm @ Brainstorming'

Process
'? @ Define the problem clearly

- %
E:a @ Analyse the problem

Collect data

8
- @ Interpret the data

Generate possible solutions




START HERE

Print this map for quick ¢ _ -
- [reference when building T ot oo 2b. This is
your first maps B ~1 acallout
2. Thisis a .
main topic o )
- insert. 2a. This is a subtopic
hyperlinks & -1 2c. Thisis a
For more ‘ — floating topic
%) S:T_aé;i,ni%% = 3a. To insert a Select the title

6. And more ...

e

A new main topic Hit ENTER
Center 1.This iIs the or INSERT
or Menu-Help-
Learning Center CENTRAL TOP_IC —|3b. To insert a Select the main topic
Type your main —new subtopic Hit INSERT
Select colors idea here

Click down on a
topic with a mouse

our ma
4 |Highlight text y &

3d. To move Drag and drop the
topics around topic where you
want it to be

4. Use the Map
“%/Marker picker to elonse the click
O3S inserticons: clease the clic

a Select with a
for text 3. Basic 3c. To pgt anyd cursor or mouse
Select colors . I ) textin edit mode ]
£ 505 line 5. Enhance s Hit F2

QuickStart map.mmap - 6/7/2005 - Mindjet Team



Studied 2 years in Japan

Need to meet :
@ I ore often Experience
Argue often / \‘
. & | .
Friends 4 : Worked 5 years in USA
Have many Vice-president
Abroad in a food company

Absent-minded

am——
Football Lazy

Weak SldeS Get bored soon

Too talkative

V/ Smart
V/ Educated
V/ Enthusiastic

. Sports .
% Hobbies
Travelling 7N

Cycling/ \ War games

I*'m working @A

onit!

Meeting people

W Like ~ “\.&1 Strong sides

Graham Greene

La vita e bella
Marques Good books
European Fims/ Run, Lola, Run
Oscar Wilde Type fast
Amelie

Fluent English

Good Japanese

Languages Macintosh

Computer skills Windows

DOS
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The MindManager X5 interface
' & @ ' ' B ' & <,
mwaallfuaasninandiudiznaudne g aaeldsunsu MindManager 7w X5 %uﬂunai“’numqﬂ
289038 Mindjet

Inain rmenu

= MindManager - [map use]

Main toolbar

!: Eie Edit  wiew Irsert  Formak Iods Actiors  window I:|B|D - B
BOW IS XD idad 0PI 2R e o Q[ F S| T
(I uap | i Modss —
Hind Managcr nm3| MinciMarager for Brainstorming | Mincharogor £ D ‘a.\PIunm...l 4 p | Library A-j Branstarm .
WDrkaDk tatls ] J =+l @ BEIEkJ]I’EILInEl i Presentabon
2 3] @ chapes Z
| HE Map Parts Modify Style
i3 Izans L PYiNE Preview
] E Images ==
Taszk pane ‘57& ¢ :=; Eg-
D @
b
o
¢ B |z
=]
" e ? )
L | 2 ?‘. e
i | T o & ™ 8N Taskpane
reostors [z @ RBT Um|#-94-A-0Q 2 ;l o
[ Formatting toolhar J Exper toohar
Help resources

szuutaowaagldnulysunsy MindManager X5
. & @ ' a & v o A a
natlu F1 mnuuldsunsvazuaaaniednsszupmiomnieluniglanudeonszuud

gasnsnnutaawae (Contents, Index, Search)

E? MindManager X5 Help

i ¢ & O

Hide Back  Pnnt  Options

Contents Index | Sean:h|

Type in the keyword ta find:

|ban::kgrn:uund

_ Images can be either attached to a topic, or
|RSS @ added as new topics or as floating images that

au ddn o vIinndiley @ 1§85 1 na 1 Your Dre



dis 1 4 5 unsu MindManager X5

a

PN ) & & D) : g
LﬁaLﬂm:uumﬂmﬁamummaLLinIﬂiLmim:memagmmanﬁmmm MindManager X5 as#

MindManager

The Visual Tool for Broinstorming and Planning
Welcome to MindManager X5

MindManagere, Mindjet's visual tool for brainstorming and planning, offers business professionals a more effective way to
electronically capture, organize, and communicate information and ideas.

As the digital alternative to note-pads, flipcharts and white boards, MindManager increases productivity through faster
understanding, better decisions and reduced meeting time.

XML-based MindManager seamlessly integrates with Microsofte Office@ and Enterprise data sets to harness corporate
knowledge.

MindManager Editions
MindManager X5 Pro maximizes performance by helping business professionals and teams achieve more in less time.
Run more effective meetings and accelerate decisions using proven content organizing methods.

X5 Pro seamlessly integrates with Microsofte Word, PowerPointe, Outlooke and Project to increase productivity and
jump-start business projects. Save time by brainstorming and planning visually, then exporting content to professional
Web pages, graphics, PDF files or MPX file format for integration with leading Project Management tools.

Smart Map Parts, built with SmartMapX Technology, support dynamic integration with third-party data sources, including
search results, news feeds, and proprietary information.

MindManager X5 features cutting-edge tools to make brainstorming and planning fast and effective. Save time and
increase productivity when managing information, outlining large documents, planning presentations, and more.

With MindManager X5, you can quickly capture and organize topics in visual hierarchies before exporting to a variety of
popular formats, including professional Web pages and presentations. X5 seamlessly integrates with Microsofte Word and
PowerPointe to strengthen communication and cut presentation prep time in half.

This latest MindManager release features a Windowse XP-hased user interface, rich text notes, and an extensive library
of icons and images to visually convey meaning.

ﬂaﬂﬁm&ﬁ'}éﬁ Help - MindManager Help iaiTlanslduilaszuutinmia

Tl =i
Hide Frint  Options

Contents | |ndex | Search

& Getting Started

U ’ ’ ’ ¢ i U v ) A &
I Contents , Index, waz Search lunsdumdayaszuutiomie dslluniw

MindManager azusastayadnatunsatvnzidua windasmnandaysanszuute

Your Dre
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6 o 2

mﬁaﬁ’tﬁﬂ@ﬂu Print Print | RaRuWsidtendainis anuulysunivazuaadnsingrsle

fau

Print Topics

Y'ou can print the selected topic or all the topics in the
zelected heading, "What would you like to do’?

() Prirtt the selected topic
() Print the gelected heading and all subtopics

[ ] l [ Caticel

Print the selected topic - Ruwianwzwatefiiaen
Print the selected heading and all subtopicx - fiaviatafidenuazmuszioatonvasinge

AINAT?

yaauTLtwaaaIn Leamning Center pane Lﬁ'aﬁﬂuﬁmmzuu Animated tutorial 4
luszuunstemndasas Learning Center azfunFoudmniuldgldnulddnusiiu

buuaeaq (@& | yoieag o) MEang
1 4 -

aaadgluansase animation presentation wainwans

]

Tutorials: Basic

(3

(4 Mavigation Basics
i Reorganizing a Map
i3 Topic Farmatting
(d Topic Mokes

i3 Task Info

id Images

i3 Map Templates

i3 Callouts

4 Map Parts

Learning Center x

Getting Started f-:}

T MindManager Owverview
[2] Sample Maps Presview

g Quickstart Map
=2] Map Templates
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JruuTEwaaawe wa Learning Center

Tutorials: Advanced ()

i Brainstorming

i3 Hyperlinks

g Styles

4 Map Markers

5 Qutline Wiew

13 Microsoft Office Integration

lusdauvas Map Gallery Tusunsa MindManager X5
IS pudagsunufianuaa3lwsndnendae
LT %Wﬂlﬁqﬁ‘lﬂ,’fﬂ L%ﬂx'iﬂﬂi'ﬂx‘iLLN%Iﬂ'Nﬂ'ﬁ@‘ﬁﬂ
wrufiaawuda (Info Map Project Planning)

Map Gallery i

C:‘a Info Map Brainstorming

E.:‘: Info Map Information Managemenk
D’e Info Map Meeting Management
l:ﬂ Info Map Project Planning

r.:‘: Sample Close the Sale

E.:‘= Sample Training Development

L'.‘ne_ Sample Web Development

l:d Sample Project Frame

Cﬂ Sample Strakeqic Business Plan

®

Your Dre
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Individually or
in agrou

Brainstorm

art major project Focus on major tasks
tasks

ct - Enter tasks as

they occur to you
~_in random order

l. Define
project tasks

Break down tasks into
separate activities or phases

Add subtasks

Create subtopics for each major task

MindManager for

2 Insert->Task Information

Project Planning

Set meaning for codes

Il. Set the Task Define priority scheme
Info scheme

Define day length and
default task duration

lcons and images for
va additional meaning
r

P

5 Line colors for easy reading
Il. Add visual cues ]ek oy TRaths

Fill/Highlights for emphasis

winm lFsudumadsunuiinnudastinglsiesandadiadng unufinnw@aain Leamning Centerd

16 iwsnzitludauuzsinaniaanBwnusem HHaa Software Ly I lae

WANBLAG | animation tuturial un9gIwLI1Rzda download NN1INNBULABTLIG AIBURINTAINNABINTHINN
T5u NazdasBandaduaasita (internet connection)

Online resources
ﬁgmﬂﬁmmﬁfum&ugﬂﬁwm Mindjet Sai3en-i1 Mindjet Support Center Vlﬁm’%wiagaﬁuq Hwnugnd

¥

Knowledge base article with answer to commin question - aanuAugwdmuaY f

aaum 9l

A user-to-user forum - ﬂi:mﬂuﬂﬂ“ﬁqﬂﬁ'ﬂﬂuifoﬂuIUSLLnsuﬁa AL I NBLANLUR

Uszaunisal

License key and registration help — suntomafuiuduansmsldlusunsa yaurs

myaanzidon

Service pack download — msanasilnaa d’mﬂ%’uﬂ;aLﬁmamaﬂﬂmﬂm

au didn 2 vIsnadidy @ 1§58 1 na 5
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PDF format help guide - tonansszuutimie (emsld) lugUuuuvasuiaenans pdf

file

Resource for advance user — nwennsfislugniy Q’L‘ﬁmui’ug@

= & [l &)
! UVLSIT@I ag1adunianng

www.mindjet.com

ﬁa%iu%ﬁ'ﬂﬁm%'umsa@@ia

For the America's, Asia and Pacific Rim:

Mindjet LLC
125 E. Sir Francis Drake
Fourth Floor
Larkspur, CA 94939 USA

Phane: +1 (415) 825-3120
Fax: +1 (415) 925-3110

Order Center: 1-877-MINDJET #c4= =20

Web sita: www.mindjet.com
E-mail: info@mindjet.com

For the United Kingdom:

Mindjet UK Ltd.
Peterbridge House

3, The Lakes

Bedford Road
Morthampton MN4 THB

Phane: +44 (0) 1604 638666
Fax: +44 (0) 1604 230910
Web site: www.mindjet.com/uk
E-mail: info@mindjet.co.uk

For English speaking Europe, Africa and the Middle East:

Mindjet GmbH Eurcpean Headquariers
Siemensstrale 30

B3755 Alzenau

Tel. +49 (0) 6023 9645 -0

Fax. +49 (0) 5023 9645 -19

Web site: www.mindjet.de

E-mail: info@mindjet.de

wihaiuladuas Mindjet
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hitkp:/ sy, mindjet comfus/! Go | Stop | Print | Refresh

l Contact Sales 1877.646,3538

Mindjet-

W Visusl Thinking

I PRODUCTS SOLUTIONS SUPPORT PARTHERS COMPAL

great things happen!

News & Events

“If wou never do any . Pro 09/23/2004: Mindjet Win:
planning, writing, Ml“dmu"ugerm Productivity Tool for Windc
research, organizing,
llearmng or thinking, then ﬁ,ﬂl:uu can pr-:ul:uall:ulﬁ_,f manage without 09/14/04: KM World: “Sca
it, But for thie rest of us, Minddanager is a must-have
product.”

discusses how attorneys us
high-level view of legal infi
the direction of a case

-- PC Pro magazine

fidanslwi 9 Manallusunsuiulna 9 16 download snnenasldam

Software Downloads

The following downloads require a valid MindManager license key to activate
the software, If vou have difficulty accessing any of these links, please click
here to use HTTP instead of FTP.

= pinddanager X5 Pro and X5
= Mindbanager ¥5 Mobile for Pocket PC
= Mindhanager ¥5 Free Wiewer
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— fevdngastineusuiineuausinnanudesnts (COUrses)
fatzmanaludisuau (Public speaking)
msrhiaueranuedsiieerdw (Presentation)
msianiuladesdns (Web site design)
msmenmszauiesw (Photography)
maBeuuruiianuaadasTdsunsuaeuiunes (Mind
Map® by computer software)
msnanszuugudeyaiugedrs M S Access
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